
Technical Overview with Self-Guided Demonstration 

Agilent
89601A Vector Signal Analysis Software
for W-CDMA and HSDPA 
Evaluation and Troubleshooting 

Measure, evaluate, and 
troubleshoot Wideband Code

Domain Multiple Access 
(W-CDMA) and High Speed

Downlink Packet Access (HSDPA)
compatible signals with the 

89601A Vector Signal Analysis
(VSA) software and its 3G 

modulation analysis Option B7N. 

This software works with a 
variety of measurement hardware

including Agilent spectrum 
analyzers, Infiniium scopes, and

the 89600 VXI systems. 



The 89601A Vector Signal Analysis software is one of the
most advanced signal analysis packages on the market
today. It combines a robust set of analysis tools with
unusual flexibility for applying and teaming these tools.
Use this robustness and flexibility to

• test your signal to its standard

• troubleshoot problems when your signal fails to meet 
its standard

Use the 89601A software to

• analyze signals as wide as 6 GHz bandwidth 
(requires Infiniium scope)

• record signals and play them back to extend analysis 
capabilities

• demodulate standards-based signals ranging from 
NADC, to W-CDMA, to 802.11g WLAN

• demodulate signals based on less common or even 
proprietary standards

• troubleshoot digitally modulated signal problems, 
isolate symbol clock errors, identify filtering  
problems, and more

• use analog demodulation to
• demodulate and analyze AM, FM, and PM modulated 

signals
• analyze settling problems in oscillators and PLLs
• locate unintentional modulation

• work in multiple domains and formats

• access a full set of markers to find peaks, measure 
frequency, phase, amplitude, offsets, simplify 
channel-power measurements, perform gated 
measurements, and more

• work with a wide selection of measurement hardware
• high dynamic range VXI bundles
• spectrum analyzers offering high dynamic range and 

up to 50 GHz frequency range
• scopes with up to 6 GHz analysis bandwidth

• integrate analysis with the Agilent EEsof Advanced 
Design System (ADS)
• analyze design simulations
• analyze product/component performance
• yield performance data for CAD substitution
• produce data for further analysis/reporting

Excellent W-CDMA/HSDPA analysis tools

Option B7N adds W-CDMA and HSDPA demodulation
capability to the 89601A VSA software.

These capabilities descramble, despread, and demodu-
late W-CDMA uplink and downlink signals. The analyzer
automatically identifies all active channels regardless of
the symbol rate or spread-code-length.

Signal analysis capabilities include composite code
domain power, composite time, and channel specific
analysis. Measurement results may be shown in several
trace display formats as well as numeric error data for-
mats. Flexible display scaling and marker functionality
enhance these measurement capabilities.

The flexible software-based 89601A W-CDMA/HSDPA
demodulator incorporates advanced technology that
does not require coherent carrier signals or symbol-
clock timing signals. It includes a built-in root raised-
cosine filter, with user-definable alpha (defines roll-off 
factor for chip shaping.) Signal locking requires only the
carrier frequency, chip rate, uplink/downlink direction,
sync type (CPICH/SCH), and scramble code be input.
The demodulator uses the measured signal, called I/Q
Meas Time, to generate an ideal signal, called IQ Ref
Time. The software uses these signals to provide com-
parison data, modulation quality data, results, and error 
summary data.

Measurement result data include: time and frequency
domain trace data, code domain power data 
(composite or layer specific), code domain error data
(composite or layer specific), channel data results, and
overall error summary results. 

If you have measurement hardware with two baseband
channels, the 89601A VSA software provides IQ base-
band measurement capability. You can also perform IQ
baseband measurements on data from a file or the
stream interface, i.e. ADS simulation.
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W-CDMA/HSDPA Modulation 
Analysis Features

These features are applicable to W-CDMA modulation
analysis

• standard presets for
• W-CDMA (3GPP) uplink (mobile station or user 

equipment)
• W-CDMA (3GPP) downlink (mobile station)

• variable, user-definable chip rate 
(3.84 MHz standard preset) 

• single layer and composite signal code-domain power 
(CDP) and code-domain error displays (the composite 
display shows all code layers simultaneously.) You can
normalize code-domain power to display the CDP 
relative to the total signal power in the code domain

• composite and single channel time-domain displays 
such as constellation, trellis and eye diagrams, IQ 
magnitude/phase error, and error vector traces

• adjustable filter alpha (default 0.22)

• mirrored (flipped) frequency spectrums can be used 
to remove the effects of high-side mixing

• measurement offset and interval (similar to time 
gating) used to select specific data slots for analysis

• flexible active channel identification for CDP and 
composite results

• automatic identification of active code-channels, using
auto or manually computed thresholds

• gated active channel identification to analyze signals 
with adaptive modulation coding (AMC)

• predefined 3GPP test models one through four 

• averaging for pre-demodulated spectrum, code domain
power, and code domain error trace data results

These additional W-CDMA features are applicable to
HSDPA modulation

• automatic modulation scheme detection for HS-PDSCH
channels using QPSK or 16QAM

• manual or automatic control of modulation scheme for
despreading HS-PDSCH channels

• gated modulation detection to analyze signals with 
AMC

• predefined Test Model 5 options as defined in Section 
6.1.1 of 3GPP TS.25.141 V5.7.0 (2003-06) Rel 5
technical specification
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Demonstration Preparation

This demonstration uses the 89601A VSA software and a
PC meeting the requirements shown in Tables 1a and b.
No measurement hardware is required because the
demonstration uses a pre-recorded signal recalled from
a file.

PC requirement Desktop Laptop

CPU 180 MHz Pentium® > 300 MHz Pentium or
or AMD-K6 (> 300 MHz AMD-K6
recommended)

Empty slots 1 PCI-bus slot 1 CardBus type II slot 

(required only if (two recommended) (two  recommended)
using measurement 
hardware)

RAM 192 MB 192 MB 

(256 MB recommended) (256 MB recommended)

Video RAM 4 MB 4 MB 

(8 MB recommended) (8 MB recommended)

Hard disk space 200 MB available 200 MB available

Operating system Microsoft® Microsoft 

Windows 2000® or Windows 2000 or

XP Professional® XP Professional

Additional drive CDROM or 3.5 inch  CDROM or 3.5 inch 

floppy (if no network floppy (if no network  

access available) access available)

Interface support IEEE 1394-19951 IEEE 1394-19951

(required only if using (FireWire), LAN, or (FireWire), LAN, or 
measurement GPIB GPIB
hardware)

Table 1a. Demonstration PC and software requirements.

Software requirements
Version v5.20, or higher

Option • –200: Basic vector signal analysis

• –300: Hardware connectivity 

(required only if measurement hardware 

will be used)

• –B7N: 3G modulation analysis

Table 1b. Demonstration PC and software requirements.
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Setup Procedures

This procedure is intended to help users get started
using the 89601A VSA software to evaluate W-CDMA/
HSDPA signals. Detailed information and explanations
of the signal and the operation of the software are 
available in the 89601A on-line Help located on the 
software’s toolbar.

Recall the W-CDMA/HSDPA example signal
The 89601A VSA software includes a pre-recorded 
W-CDMA/HSDPA signal. Recall this recording as shown
in Table 2.

The following pre-recorded W-CDMA signals are also
provided in the default signal directory but are 
not used in this procedure

• 3GPPDown.sdf (W-CDMA downlink)

• 3GPPUp.sdf (W-CDMA uplink)

Setup the RF measurement parameters
Set the RF parameters, as shown in Table 3, to measure
the pre-recorded W-CDMA/HSDPA signal.

Connecting the signal to the analyzer 
No hardware is required to analyze the recorded signal
used in this procedure.  

The 89601A software can analyze RF and baseband (I/Q)
signals. Refer to the 89601A on-line Help for information
on HSDPA or W-CDMA hardware set-up. Refer to the
Ordering Information at the end of this document for
information on measurement hardware.

Center frequency
Center frequency does not need to be exact, only within
±500 Hz, because the VSA will make the final adjust-
ments automatically. 

For W-CDMA downlink with the SCH sync type, the 
center frequency may need to be within ±300 Hz of 
the carrier frequency.

Frequency span
When preparing to demodulate a signal, it is usually 
best to select a span that is slightly larger than the 
bandwidth of your signal. If you select a span that is too
narrow, your measurement may have excessive errors or
the software may lose carrier lock. Use a span set as 
follows 

Frequency span ≥ chip rate x (1+filter alpha)

Instructions Toolbar menus

Go to the default File > Recall > Recall Recording
signal directory 
(c:\Program Files\
Agilent\89600VSA\
Help\Signals)

Select the recording 3GPPTM5H8D30.sdf > Open

Start measurement Click on “   “ (toolbar, left side)

Table 2. Signal recall instructions.

Instructions Toolbar menus

Set center frequency MeasSetup > Frequency
and frequency span > Center Enter: 1.85625 GHz

> Span Enter: 5.0 MHz
> Close

Set input range Input > Range > Range 
Enter: –16 dBm
> Close

Auto scale trace A Place cursor in trace A, right click the mouse 
> Y Auto Scale

Table 3. RF parameters setup.
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For best results with W-CDMA/HSDPA signals, the 
frequency span should be set according to the following
formula 

Frequency span ≥ chip rate x 1.22

Input range
The input range must be set correctly to obtain accurate
measurements. Input ranges that are too low overload
the hardware front-end. Input ranges that are too high
increase noise, which increases errors reported in error
data results, such as error vector magnitude (EVM.) In
general, set input range as low as possible without over-
load.

Setting the input range is not required on this pre-
recorded signal. The example sets the input range only
to illustrate how to use the input range control.

Y Auto Scale
Clicking Y Auto Scale rescales and repositions the
active trace to ensure that all points fall within the
bounds of the trace display on the Y-axis. Unlike 
spectrum analyzers, the Y-axis scale is not tied directly
to the input range. Changing the Y-axis scale does not
change the input range attenuation of the measurement
hardware.  
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Setup the demodulator
Select the W-CDMA/HSDPA demodulator as shown in
Table 4.

You should always view the signal spectrum first to be
sure that the signal is present, and that the center 
frequency, span, and input range are correct before
selecting a demodulator.

After selecting the demodulator, you need to set its
parameters. The software will do this automatically if
you select one of the available Preset to Default choices,
or you can configure the demodulator manually using
the Demod Properties menu.

By default, traces A, C, and D show displays of the com-
posite signal. Trace B shows the signal’s spectrum. Note
that trace D shows the Composite Error Summary table.
This table contains error information for your signal.
Common error parameters, such as EVM and frequency
error (Freq Err) provide quick indicators that show you
the quality of your signal.

For details about 3GPP displays, see About Trace Data
(W-CDMA) in the 89601A on-line Help.

Instructions Toolbar menus
Select the demodulator MeasSetup > Demodulator > 3G Cellular 

> W-CDMA(3GPP)/HSDPA

Preset demodulator MeasSetup > Demod Properties > 
parameters to Downlink Format (tab) > Preset to Default… >
and enable HSDPA Downlink > Enable HSDPA analysis > Close
analysis

Add four traces to the Display > Layout > Grid 3x2
display

Start the measurement Click on “   “
(the traces may take 
several seconds to 
fill/update)

Table 4. Demodulation setup.
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Composite Measurements

A composite measurement is a measurement made on 
all channels at once. These measurements include: 
composite code domain power (CDP), composite code
domain error (CDE), as well as time domain measure-
ments such as rho, EVM, EVM spectrum, and EVM time.
These measurements are useful for evaluating the over-
all in-band performance of the W-CDMA/HSDPA signal. 

Composite vector diagram and error summary table

The steps shown in Table 5 set up the composite 
constellation and Composite Error Summary table.
(These steps are provided for instruction purposes. The
same information is already available in traces C and
D of the previous step.)

Trace A: Composite measurement time 
(constellation display) 
This constellation is quite noisy but is characteristic of
the composite W-CDMA/HSDPA signal. Seeing this shape
provides an indication the demodulator is setup properly.

Trace B: Composite error summary
The composite error summary display shows you the 
following measurement results for the composite signal.

Composite EVM (EVM) is the error vector magnitude for
the composite signal, including all spread code lengths
and code channels. The table shows RMS percentage
EVM, the peak (largest) percentage EVM, and the chip
number with the peak percentage EVM. This parameter
is computed at the chip rate. 

Composite magnitude error (Mag Err) is the difference
in amplitude between the I/Q measured signal and the
I/Q reference signal for the composite signal.

The display shows these magnitude error values: the
RMS percentage magnitude error, the peak percentage
magnitude error, and the chip number with the peak
percentage magnitude error.

Instructions Toolbar menus

Set the display to a Display > Layout > Stacked 2
stack of two traces

Change trace A to Double click on trace A’s title (upper left corner
show composite IQ of trace) > Channel 11 Comp > IQ Meas Time >
time (vector diagram) OK

Auto-scale trace A Right click on trace A > Y Auto Scale

Change trace B to Double click on trace B’s title (upper left corner
show the composite of trace) > Channel11 Comp > Error Summary 
error summary table > OK

Table 5. Composite constellation and composite error summary
setup.
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Composite phase error (Phase Err) is the difference, in
phase, between the I/Q reference signal and the I/Q
measured signal for composite signal, including all
spread code lengths and code channels.

The display shows these phase error values (in degrees):
the RMS phase error, the peak phase error, and the chip
number with the peak phase error.

Composite IQ offset, also called I/Q origin offset, indi-
cates the magnitude of the carrier feed-through signal.
When there is no carrier feed-through, IQ offset is zero
(infinity dB). See EVM time and EVM spectrum in this
section for a second measure of carrier leakage.

Composite frequency error (Freq Err) shows the 
composite signal carrier frequency error relative to the
analyzer's center frequency. This parameter is displayed
in Hertz and is the amount of frequency shift, from the
analyzer's center frequency, that the analyzer must 
perform to achieve carrier lock.

Composite rho is the normalized correlation coefficient
between the measured and ideal reference signals and 
is designated as the waveform quality factor. The 
maximum value of rho is 1.0, which means the measured
signal and reference signal are identical.

Composite slot identifies the time slot used for the 
composite measurements. The composite slot ignores the
measurement offset.

Composite T trigger shows the amount of time, in chips,
from the trigger to the start of the frame. If you select a
trigger that starts the measurement at the beginning of a
PCG, the T trigger value is zero chips. The T trigger
value is displayed only for triggered measurements.

Composite peak active CDE is the largest active code
channel code domain error (in dB). This is the largest
measured CDE of all active code channels in the com-
posite signal.

Composite peak CDE is the largest measured code chan-
nel code domain error. This is the largest measured CDE
for all code channels (active and inactive) in the base
code layer (the code layer with the smallest symbol rate)
in the composite signal.

If averaging is on, averaging is applied to most numeric
error data in the error summary data with the following
exceptions. The peak data values, such as peak EVM,
peak magnitude, and peak phase error, are averaged
only for the continuous peak hold averaging type.
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Composite CDP and CDE

CDP and CDE measure the power and error of the signal
by code channel. They provide more detail on signal
behavior and modulation quality than the composite
EVM or rho.

The steps shown in Table 6 take you through setting up
these measurements.

Trace A: Composite CDP
The CDP trace shows the power in every channel in the
composite signal. CDP is an analysis of the distribution
of signal power across the set of code-channels, normal-
ized to the total signal power. If the measurement inter-
val (MeasSetup > Demod Properties > Time) is greater
than one, all slots within the measurement interval are
averaged together to produce the composite CDP results.

The trace assigns a unique color to each code layer and
related active code-channels to make it easier to distin-
guish the active code-channels (Code-Channel) for a
given code layer (Spread-Code-Length). Use the marker
(see next step) to determine the color assigned to each
code layer. In this example spread code length 256 is
orange, spread code 128 is blue, and spread code 16 is
yellow. These colors are user-definable (Display >
Appearance > Color (tab).)

Trace B: Composite CDE
This trace shows the channel power error values for
each active code channel for all code layers (Spread-
Code-Lengths). It also shows the CDE value for each
inactive code channel at the lowest code layer. The CDE
of a particular code-channel is a measure of the error
power in a code-channel relative to the total signal
power. When IQ normalization is on, the CDE is
expressed in dBc and is relative to the total power in the
signal. When IQ normalization is off, the CDE is
expressed in dBm.

CDE composite trace data results are computed only
from the first measured slot. 

Instructions Toolbar menus
Add two more grids to Display > Layout > Grid 2x2
the display so CDP and 
CDE can be shown

Change trace A to show Double click on Trace A’s title >
composite CDP Channel 11 CDP > CDP composite > OK

Auto-scale trace A Right click on trace A > Y Auto Scale

Change trace B to show Double click on Trace B’s title >
composite CDE Channel 11 CDP > CDE composite > OK

Auto-scale trace B Right click on trace B > Y Auto Scale

Table 6. Setup of CDP and CDE.
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Markers

The 89601A VSA software includes several markers and
marker functions accessible from the Markers menu.
Each trace has its own set of markers. You can quickly
set marker locations, manually re-position them, locate
peak values, and couple the markers between traces to
show common values. Marker calculation features allow
you to easily calculate band power, RMS band power,
and channel-to-noise power.

Markers also help you understand the information pre-
sented in a trace. For W-CDMA/HSDPA modulation, the
CDP and CDE displays assign a unique color to each
code layer and related active code-channels to make it
easier to distinguish the active code-channels for a given
code layer (Spread-Code-Length). If you place the mark-
er on each color, the marker readout at the bottom of
the display will show the code layer and code channel
for that color.  

Trace A: Composite CDP, bit reverse code order, 
with markers 
The bit-reversed generation of code channels displays
related code channels adjacent to each other.  

The marker is on a blue colored channel and shows the
following values (bottom of screen):

Symbol rate 30 Ksym/s
Spread code length 128
Code number 9
Power level –15.077 dB
Asterisk * The asterisk indicates the 

marker is positioned on an 
active channel

Trace B: Composite CDE, Hadamard order 
This trace shows the code channels in the Hadamard
order. Note that the marker automatically points to all of
the parts of the code channel as it is spread by the
Hadamard ordering.

Instructions Toolbar menus
Enable the trace A Click on trace A > Markers > Tool > Marker
marker (the marker OR
may be moved by Right click on trace A > Show Marker
dragging it with the 
cursor)

Enable the trace B Right click on trace B > Show Marker
marker

Change the code order Click on trace B > Trace > Digital Demod > 
in trace B to bit reverse Code Order (drop down menu) > Hadamard > 

Close

Table 7. Marker setup.
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EVM time and EVM spectrum 

Two useful displays for evaluating the behavior of the
composite signal are error vector time and error vector
spectrum. The steps shown in Table 8 will take you
through setting up these measurements.

Trace A: EVM time
Error vector time shows the EVM behavior over time,
where chips represent time. You can view EVM time data
as EVM, error vector phase, the I component, or the Q
component. This feature is used to find impulsive errors
such as a transient overload event or a spiking clock cir-
cuit. It is also useful for finding low frequency errors
caused by close-in phase noise. Trace A is typical of a
signal without any of these problems. It is relatively flat
and consistent across all 2.551 kchips of time.

Trace B: EVM spectrum
Error vector spectrum is the FFT of the EVM time trace
and shows the frequency content of the EVM. Trace B
shows a high error signal at 1.856 GHz (Trace B marker
value at bottom of display.) This is the signal carrier 
frequency and represents carrier feed through. Carrier
feed through is not the only signal the EVM spectrum
trace will show. Any spurious signal will show up as a
discrete peak in the composite error vector spectrum
trace.

The analyzer's demodulator removes carrier-frequency
error. Therefore, in the composite error vector spectrum
display, you must add the carrier-frequency error to
marker readouts to obtain exact frequency information.
The carrier-frequency error (Freq Err) is shown in the
Composite Error Summary table.

Instructions Toolbar menus
Setup a display with Display > Layout > Stacked 2
only two vertically 
stacked traces

Set the top trace to Double click on the top trace’s title > Channel 1
display error vector Comp > Error Vector Time
time

Set the bottom trace Double click on the bottom trace’s title > 
to display error vector Channel 1 Comp > Error Vector Spectrum
spectrum

Enable a marker in the Click on the bottom trace > Markers > Tool > 
bottom trace Marker

OR
Right click on the bottom trace > Show Marker

Put the marker on the Right click on the bottom trace > Peak
peak near the center of 
the trace

Start the measurement Click on “   “

Table 8. EVM time and spectrum setup.
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Channel Measurements

Measuring a single channel

The instructions in Table 9 show how to use markers
and the Copy Marker to Despread Chan function to
quickly view a single channel in your W-CDMA/HSDPA
signal. You can also go directly to the desired channel by
entering its parameters in the Demod Properties menu.

Copy Marker to Despread Chan sets the despread 
channel parameters including: spread code length, code
channel, IQ branch. These parameter enable the follow-
ing measurements: channel error vector, channel IQ
measurement time, channel IQ reference time, channel
mag error, channel phase error, and chan syms/errs
trace data. 

Trace A: Ch1 Composite CDE
See the previous section.

Trace B: Ch1 Chan Error Vector Time   
This trace shows how the EVM changes with time (where
symbols represent time) for a single code-channel within
a specified code layer (Spread-Code-Length/Symbol Rate.) 

The error vector time trace is made up of complex, 
time-domain data. Each point in the trace has two com-
ponents: I and Q. To make sense of the data you must
select an appropriate trace data format (Trace > Format
> Format: drop-down list.)  

Linear mag Shows the EVM
Real (I) Shows the I component of the error 

vector
Imag (Q) Shows the Q component of the error 

vector
Wrap phase Shows error vector phase

The ideal error vector time trace is low level and rela-
tively flat. Notice the errors shown in trace B. These
errors are caused by the Sync signal that comprises ten
percent of each slot in a 3GPP downlink signal. Because
the Sync signal is not orthogonal, it increases the EVM.

Instructions Toolbar menus
Setup a 2x2 display grid Display > Layout > Grid 2x2

Pause the measurement Click on ||  (left side of toolbar)
(this speeds the set up 
by delaying display 
updates until all displays 
are changed)

Set trace A to display Double click on trace A’s label > Channel 1 CDP
Composite Code > CDE composite > OK
Domain Error

Auto-scale trace A’s Right click on trace A > Y Auto Scale
vertical scale to get 
better resolution 

Enable the trace A Right click on trace A > Show Marker
marker

Send the marker to the Right click on trace A > Peak
channel with the 
highest CDE

Select the marked Right click on trace A > Copy Marker to
channel for more Despread Chan
detailed analysis

Change Trace C to Double click trace C’s title > Channel 1 Chan >
display the vector IQ Meas Time > OK
diagram for the 
selected channel

Change Trace D to Double click on trace D’s title > Channel 1 Chan
display the symbol > Syms/Errs > OK
table for the selected 
channel

Change Trace B to Double click on trace B’s title > Channel 1 Chan
display the Error > Error Vector Time > OK
Vector Time trace for 
the selected channel

Start the measurement Click on “   “

Table 9. Instructions for viewing a single channel.

13



Trace C: Ch1 240 ksym/sec S16(13) measured time
(vector constellation diagram)
The Channel IQ Meas trace is the demodulated time
data, re-sampled at the chip times, for the specified
code-channel and code layer (Spread-Code-Length). The
data is corrected for IQ origin offset, burst amplitude
droop compensation, filtering, and system gain normal-
ization.

Trace D: Ch1 Syms/Errs
The symbol table in Trace D provides both error summa-
ry information and demodulated bits for the selected
channel. For W-CDMA downlink signals, the symbol
table also shows information about the demodulated
channel, such as the number of pilot bits detected in the
DPCH channel, the tDPCH timing value for the DPCH
channel, and the first slot used in the measurement. For
details about the symbol table, see on-line Help “About
the Channel Symbol Table (W-CDMA).” For details
about error information in the symbol table, see 
on-line Help “About Channel Error Summary Data 
(W-CDMA).”
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Measuring code layer CDP and CDE  

The instructions in Table 10 show how to measure code
domain power and code domain error for a specific
spread code length, or layer.

Trace A: Code domain power (Layer S16)
This trace shows the CDP trace data for all code-chan-
nels within the specified code layer (Spread-Code-
Length.) If the measurement interval is greater than one,
all slots within the measurement interval are averaged
together to produce the CDP Layer results.

Trace B: Code domain error (Layer S16)
This trace shows the channel power error values for
each code channel within the specified code layer
(Spread-Code-Length.) The CDE of a particular code-
channel is a measure of the error power in a code-
channel relative to the total signal power. CDE layer
trace data results are computed only from the first
measured slot. This is different than CDP layer trace
data results, which can include more than the first slot
in the measurement results.

Instructions Toolbar menus
Select trace A and setup Click on trace A
a display with only two Display > Layout > Stacked 2
vertically stacked traces

Set the demodulator to MeasSetup > Demod Properties >
measure the CDP for Channel/Layer (tab) > Spread code length > 
SF16 16 (240 ksym/s) (drop down menu) > Close

Set trace A to display Double click on trace A’s label > Channel 1
the CDP for the layer CDP > CDP layer > OK

Auto scale trace A Right click on trace A > Y Auto Scale

Set trace B to display Double click on trace B’s label > Channel 1
the CDE for the layer CDP > CDE layer > OK

Auto scale trace B Right click on trace B > Y Auto Scale

Table 10. CDP and CDE measurement setup.
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Test model

This selection provides a method to override the 
automatic active code channel detection algorithm with
known 3GPP test models. It lets you specify a 3GPP 
test model to use as the basis for the reference signal in
W-CDMA analysis. This bypasses the automatic active
channel identification section of the W-CDMA analysis
algorithm. Test model setting is useful if you are working
with a known test model signal, or are trying to under-
stand the problems of a signal intended to match a
known 3GPP test model. Test model parameters only
apply to the downlink signals.

The analyzer allows you select from the following list of
predefined transmitter test model configurations
(MeasSetup > Demod Properties > Test Model)

None (Default)
Does not use a test model for automatic active channel
detection

Test Model 1 
Allows further selections of Test Model 1 with 16, 32, or
64 DPCH channels, and to select a test model with or
without S-CCPCH.

• 16 DPCH w/S-CCPCH – Select this to set the active 
channel detection to the Test Model 1 with 16 DPCH 
channels and 1 S-CCPCH channel

• 32 DPCH w/S-CCPCH – Select this to set the active 
channel detection to Test Model 1 with 32 DPCH 
channels and 1 S-CCPCH channel

• 64 DPCH w/S-CCPCH – Select this to set the active 
channel detection to Test Model 1 with 64 DPCH 
channels and 1 S-CCPCH channel

• 16 DPCH – Select this to set the active channel 
detection to the Test Model 1 with 16 DPCH channels 
and no S-CCPCH channel

• 32 DPCH – Select this to set the active channel 
detection to Test Model 1 with 32 DPCH channels and 
no S-CCPCH channel

• 64 DPCH – Select this to set the active channel 
detection to Test Model 1 with 64 DPCH channels and 
no S-CCPCH channel

Test Model 2
Allows further selections of Test Model 2, with or 
without S-CCPCH

• Selected – Set the active channel detection to Test 
Model 2 with S-CCPCH

• Cleared – Set the active channel detection to Test 
Model 2 and no S-CCPCH

Test Model 3
Allows further selections from Test Model 3 with 16 or
32 DPCH channels, and to select a test model with or
without S-CCPCH.

• 16 DPCH w/S-CCPCH – Select this to set the active 
channel detection to Test Model 3 with 16 DPCH 
channels and 1 S-CCPCH channel

• 32 DPCH w/S-CCPCH – Select this to set the active 
channel detection to Test Model 3 with 32 DPCH 
channels and 1 S-CCPCH channel

• 16 DPCH – Select this to set the active channel 
detection to Test Model 3 with 16 DPCH channels and 
no S-CCPCH channel

• 32 DPCH – Select this to set the active channel 
detection to Test Model 3 with 32 DPCH channels and 
no S-CCPCH channel

Test Model 4
Allow further selections of Test Model 4, with or without
P-CPICH.

• Selected – Set the active channel detection to Test 
Model 4 with P-CPICH channel

• Cleared – Set the active channel detection to Test 
Model 4 and no P-CPICH channel

Test Model 51

Allow further selections of Test Model 5 with 2, 4, or 
8 HS-PDSCH channels.

• 2 HS-PDSCH w/6 DPCH – Select this to set the active 
channel detection to the Test Model 5 with 
2 HS-PDSCH channels and 6 DPCH channels

• 4 HS-PDSCH w/14 DPCH – Select this to set the 
active channel detection to the Test Model 5 with 
4 HS-PDSCH channels and 14 DPCH channels

• 8 HS-PDSCH w/30 DPCH – Select this to set the 
active channel detection to the Test Model 5 with 
8 HS-PDSCH channels and 30 DPCH channels
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Additional Measurements

Channel power

The 89601A VSA band power measurement determines
the total power in a user-specified bandwidth. This is
used to make standards-based channel power measure-
ments by setting the bandwidth and center frequency of
the band power marker to the values called out in the
standard.

The following band power measurement parameters are
user-controlled

• center frequency

• bandwidth

• number of averages (in MeasSetup > Average menu)

• power calculation
band power (dB)
RMS Sqrt power (Vrms) 
C/N – carrier to noise power (dB)
C/No – carrier to noise density (dB/Hz) 

Instructions Toolbar menus
This measurement is made on the spectrum of the signal. Refer to Setup
the RF measurement parameters section of Setup Parameters.

Activate the band Right click the trace > Show Band Power
power marker in the 
spectrum trace

Set the center Markers > Calculation > Center, Width
frequency and span for Center: 1.85625 GHz
the measurement Width: 3.84 MHz 

Select the power Markers > Calculation > Calculate > Band
calculation Power

Optional:  Activate a Right click on trace > Show Marker
marker and put it at the 
center frequency 
(shows frequency and Markers > Position > X Position
power at center of span) Enter: 1.85625 GHz

Optional:  Average the Click on trace A > MeasSetup > Average >
power measurements Average Type > RMS (Video) Exponential (drop 

down menu) > Count 
Enter: 250
> Close

Table 11. Channel power setup.
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Power statistics (CCDF)

The complementary cumulative distribution function
(CCDF) characterizes the power statistics of a signal by
plotting the peak-to-average power ratio (PAR) versus
probability of occurrence. This is a key measurement 
for power amplifiers designed for W-CDMA/HSDPA base
stations as these devices must be capable of handling
the PAR of the digitally modulated signals while main-
taining good adjacent channel leakage performance. 

In the example the average power of the signal is 
–20.64 dBm (top center of grid) and only 0.099 m% of all
signal peaks measured were more than 8.26 dB above
the signal’s average power.

Instructions Toolbar menus
This measurement is made on the time trace of the signal. Refer to Setup
the RF measurement parameters section of Setup Procedures. The digital
demodulators must be off for this measurement to work. 
(MeasSetup > Demodulator > Demod Off)

Change the Main time Double click on the trace title (upper left corner
trace to CCDF of grid) > Channel 1 > CCDF

Start the measurement Click on “    “ 

Activate a marker on the Right click on the trace > Show Marker
CCDF trace

Find the PAR needed to Drag the marker along the CCDF plot until the
assure the signal will marker readout at the bottom of the display
be clipped < 0.1 percent shows < 100 m%
of the time 

If the bottom of the CCDF graph is jagged (looks like stair steps) keep 
running the measurement. CCDF is a statistical measurement and gives
best results with large sample sizes. The sample size is shown as “Pts”
parameter at the top of the CCDF trace.

The “Avg” parameter shows average measured signal power.

Table 12. Power statistics setup.
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Key Menu Reference

Demod properties menu
Access these menus via the toolbar by clicking
MeasSetup > Demod Properties (the W-CDMA/HSDPA
demodulator must be selected.) For more information 
on the functions controlled by the menu click the Help
button in the lower right corner of the menu.

Demod Properties menu > Format tab

Demod Properties menu > Channel/Layer tab

Demod Properties menu > Time tab

Demod Properties menu > Test Model tab

Demod Properties menu > Advanced tab
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Trace data menus
Access this menu by clicking Trace > Data > Ch1 Chan
in the toolbar or by double clicking on the trace title
annotation at the upper left corner of the trace you wish
to change.

For more information on the functions controlled by the
menu click the Help button in the lower right corner of
the menu.

Trace data menu > Type: Channel 1 > Data (display)
menu selections

Trace data > Type: Channel 1 CDP > Data (display)
menu selections

Trace data > Type: Channel 1 Chan > Data (display)
menu selections

Trace data > Type: Channel 1 Comp > Data (display)
menu selections
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Ordering Information

The 89601A VSA software works with a variety of meas-
urement hardware, and sourcing hardware, and other
software. 

In general, an external PC with LAN, FireWire, or GPIB
interface is required to run the software and control the
hardware.  

Vector signal analysis software

89601A VSA software, node locked license
89601AN VSA software, floating license
Opt 200 Basic analysis software
Opt 300 Hardware connectivity
Opt AYA Flexible vector modulation analysis
Opt B7N 3GPP modulation analysis
Opt B7R WLAN modulation analysis
Opt 105 Advanced design system streaming interface

Measurement Hardware

Vector signal analyzer bundled systems1

(Two baseband channels and/or two RF channels available)

Models Frequency range Max. analysis bandwidth

89610S DC to 40 MHz 40 MHz
89611S 52 to 88 MHz 36 MHz
89640S DC to 2.7 GHz 36 MHz
89641S DC to 6.0 GHz 36 MHz
89650A 3 Hz to 26.5 GHz 80 MHz

PSA Series spectrum analyzers

Models Frequency range Max. analysis bandwidth

E4440A 3 Hz to 26.5 GHz 8 MHz
E4443A 3 Hz to 6.7 GHz 8 MHz
E4445A 3 Hz to 13.2 GHz 8 MHz
E4446A 3 Hz to 44 GHz 8 MHz
E4448A 3 Hz to 50 GHz 8 MHz

ESA-E Series spectrum analyzers

Models Frequency range Max. analysis bandwidth

E4401B 9 kHz to 1.5 GHz 10 MHz
E4402B 9 kHz to 3.0 GHz 10 MHz
E4404B 9 kHz to 6.7 GHz 10 MHz
E4405B 9 kHz to 13.7 GHz 10 MHz
E4407B 9 kHz to 26.5 GHz 10 MHz

Infiniium oscilloscopes

Models Frequency range Max. analysis bandwidth

54830B/D DC to 780 MHz 780 MHz
54831B/D DC to 780 MHz 780 MHz
54832B/D DC to 1.0 GHz 1 GHz
54853B2 DC to 2.5 GHz 2.5 GHz
54854B2 DC to 4.0 GHz 4 GHz
54855B2 DC to 6.0 GHz 6 GHz

Sources

ESG Series digital RF signal generators

E4431B 250 kHz to 2 GHz
E4432B 250 kHz to 3 GHz
E4433B 250 kHz to 4 GHz
E4434B 250 kHz to 1 GHz
E4435B 250 kHz to 2 GHz
E4436B 250 kHz to 3 GHz
E4437B 250 kHz to 4 GHz
E4438C 250 kHz to 1/2/3/4/6 GHz

PSG Series microwave signal generators

E8267 250 kHz to 20 GHz

Software

Advanced Design System (ADS) software 
Advanced RF/µW design and simulation software.
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Agilent Technologies’ Test and Measurement Support, Services, and Assistance
Agilent Technologies aims to maximize the value you receive, while minimizing your
risk and problems. We strive to ensure that you get the test and measurement
capabilities you paid for and obtain the support you need. Our extensive support
resources and services can help you choose the right Agilent products for your
applications and apply them successfully. Every instrument and system we sell has
a global warranty. Support is available for at least five years beyond the production life
of the product. Two concepts underlie Agilent’s overall support policy: “Our Promise”
and “Your Advantage.”

Our Promise
Our Promise means your Agilent test and measurement equipment will meet its
advertised performance and functionality. When you are choosing new equipment, we
will help you with product information, including realistic performance specifica-
tions and practical recommendations from experienced test engineers. When
you use Agilent equipment, we can verify that  it works properly, help with
product operation, and provide basic  measurement assistance for the use of
specified capabilities, at no extra cost upon request. Many self-help tools are avail-
able.

Your Advantage
Your Advantage means that Agilent offers a wide range of additional expert test
and measurement services, which you can purchase according to your unique tech-
nical and business needs. Solve problems efficiently and gain a competitive edge 
by contracting with us for calibration, extra-cost upgrades, out-of-warranty repairs,
and onsite education and training, as well as design, system integration, project
management, and other professional engineering services. Experienced Agilent
engineers and technicians worldwide can help you maximize your productivity, opti-
mize the return on investment of your Agilent instruments and systems, and obtain
dependable measurement accuracy for the life of those products.  

www.agilent.com/find/emailupdates
Get the latest information on the products and applications you select.

Agilent T&M Software and Connectivity
Agilent’s Test and Measurement software and connectivity products, solutions and
developer network allows you to take time out of connecting your instruments to
your computer with tools based on PC standards, so you can focus on your tasks,
not on your connections. Visit www.agilent.com/find/connectivity for
more information.

By internet, phone, or fax, get assistance with all your test & measurement needs

Online Assistance:
www.agilent.com/find/assist
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without notice.
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